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Preface

This preface contains the following sections:

• Documentation accessibility

• Related resources

• Access to Oracle Support

Documentation accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Related resources
All documentation and other supporting materials are available on the Oracle Help Center at: 
https://docs.oracle.com/en/industries/health-sciences/cleartrial/index.html

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through
Support Cloud.

Contact our Oracle Customer Support Services team by logging requests in one of the
following locations:

• English interface of Oracle Health Sciences Customer Support Portal (https://
hsgbu.custhelp.com/)

• Japanese interface of Oracle Health Sciences Customer Support Portal (https://hsgbu-
jp.custhelp.com/)

You can also call our 24x7 help desk. For information, visit http://www.oracle.com/us/support/
contact/health-sciences-cloud-support/index.html or visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=trs if you are hearing impaired.
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1
Changes in Update 5.8.5

Release 5.8.5 added new and enhanced capabilities to the Oracle Health Sciences ClearTrial
Plan and Source Cloud Service providing increased flexibility, configurability, and efficiency to
your study planning and outsourcing processes. These enhancements focused on making
your planning and budgeting experience more efficient and useful.

This software update does not include a new ClearTrial Cost Model.

• Plan Summary Enhancements

• Plan Indirect Cost Enhancements

• Other Usability Enhancements

• Plan Reporting Enhancements

• Transparent Subscription Status/Usage Reporting

• Best Practices

Plan Summary Enhancements
Group Plan Summary by Category, Department, GL Code or Resource

ClearTrial 5.8.5 offers new capabilities and flexible control over how to group, view and report
on labor and costs displayed on the Plan Summary tab and Plan Summary report. Once you
have labor and costs mapped as per your organization’s operational hierarchy/functional
areas, you can control how you want the data summarized.

In addition to Summary Group, which is renamed Summary Category in 5.8.5, you have the
flexibility to group fees by Department, GL Code, or Resource and costs by Department or
GL Code.

The presentation/order of results displayed has also been refined to display the most
important values first.

A new Totals section is displayed first, composed of the Total Study Budget broken out by
subtotals for Fees and Pass-Through Costs (indirect costs), each broken out further with and
without inflation.

Fees, Hours, and FTEs are displayed according to the grouping selected. Indirect costs are
broken out by cost type. Dates/Duration, and Metrics are displayed at the bottom.

Plan Summary Report Enhancements

The new Group By section offers new reporting options to summarize the output when
running the Plan Summary report from the Plan Reports tab.

You can choose to group by…

• Category

• Department
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• GL Code

• Resource

You can also choose to render the report using the new layout, which presents the
most important information first, or using the “classic” layout, which displays totals
inline.

If you want the report to use the 5.8 summary layout/format, select a group by option
and then select the Use Classic Layout option.

Plan Indirect Cost Enhancements
Display Expanded Costs and Show Assignments by Location

The Plan Costs tab now supports the ability to expand costs that vary by location to
display the location-specific values without editing the cost. To expand all location-
scoped costs, select Filter > Show per location values and assignments.

The Plan Costs tab now also has an additional column to display the provider
responsible for the cost or the department or the GL Code. This column displays
different information by clicking the icon in the column header to cycle between the
assigned provider, department and GL Code.

When the costs are collapsed, that is, you have not selected to Show per location
values and assignments, this column will display either the value common to all
locations or a message indicating that there are multiple providers, departments, or GL
codes associated with the cost in each of the various locations.

Rename ClearTrial-defined Indirect Costs

You can now edit the name of a ClearTrial-defined cost, instead of excluding the cost
and creating a new one.

If you have a similar cost in your planned budget but need to rename it to reflect your
budget’s line item, you can simply select and edit the ClearTrial-defined cost from the
Costs list, rename the cost, change any other attributes or assignments (if applicable)
and save.

Other Usability Enhancements
The updates described in this section, aim to improve the ease of use, maximize
efficiency, and provide a more useful and enjoyable user experience with ClearTrial.

Remodeled Plan and Portfolio Reporting Menus

Available reports can now be viewed as thumbnails or as list items on the Plan and
Portfolio Reports tabs to better recognize those reports you are interested in
generating.

Also, includes the capability to collapse reporting section headers to hide reports in
which you are not interested.

Clear Major Task Distribution Values

You can now quickly clear all default or user-defined Major Task distribution values in
one-click, for a custom distribution. Plan Labor tab > Edit a Major Task > Distribution >

Chapter 1
Plan Indirect Cost Enhancements
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Distribute completed units of work according to A Custom Distribution, displays a new link,
Clear Custom Distribution Values.

Clear Cost Distribution Values

You can now quickly clear all default or user-defined pass-through or miscellaneous cost
distribution values in one-click, for a custom distribution. Plan Costs tab > Edit a Cost >
Distribution> Distribute according to A Custom Distribution, displays a new link, Clear
Custom Distribution Values.

Clear Subject Enrollment Distribution Values

You can now quickly clear all default or user-defined subject enrollment distribution values in
one-click, for a custom, weekly enrollment distribution. Plan Subject tab > select Custom for
enrollment distribution type > Manage location-specific values per location> change to
Weekly distribution > displays a new link, Clear Custom Values.

Clear Site Approval Schedule Values

You can now quickly clear all user-defined site values entered per week or day in one-click,
for a default or user-defined site approval schedule by location. Plan Site tab > Click the User
Defined Site Approval Schedule link for a location, displays a new link, Clear User Values. If
you want to clear entered values for a ClearTrial Default Site Approval Schedule, Click on the
ClearTrial Default Site Approval Schedule link for a location, enter values per week/day,
displays a new link, Clear User Values.

New Customer Preference

Customers can now control the Number of weeks to show on each page of the Treatment
Schedule to configure the number of weeks displayed per page.

The Treatment Schedule dialog displays 52 weeks per page by default.

ClearTrial 5.8.5 allows values between 10 and 520. If the performance of the dialog becomes
slow, reduce the number of weeks displayed per page.

Assigned ClearTrial System Administrators can access Customer Preferences, which
contains the configurations to be set for all users, by selecting Admin > Customer
Preferences from the main menu, or Maintain > Preferences from the Start Page.

Filter Plans Created or Modified in the last 4, 5, 10 Years

You can now create filters to display plans created or modified in the last 4, 5, and 10 years to
quickly find plans for longer duration trials by clicking the Modify link when defining plan filter
criteria and changing the value for Created or modified in the last <specify duration>, on the
Plan List screen.

Count and Display Number of Portfolio Plans Selected

The Add Plans to Portfolio dialog now includes a counter for the number of plans selected
with the capability to clear and remember selections across pages. The Portfolio plan count
indicator is also displayed when selecting or deselecting plans from Edit Portfolio > Plans tab.

Sorting and Paging Studies and Templates when Creating a New Plan

The list of studies and templates on the New Plan Dialog are now sortable by clicking on a
column header. The list of studies and templates are also now paginated allowing the dialog
to display more quickly for customers with hundreds of studies and/or templates.

Chapter 1
Other Usability Enhancements
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Navigate to the Plan List screen > Click New to display the New Plan Dialog. Click on
a column header to sort either list and/or navigate to the page that displays the study
you want to plan and/or the template you want to use.

WBS Report by Cost Model

Adds the capability to select the ClearTrial Cost Model when generating the WBS
reports from Report > WBS: Late Stage or WBS: Phase I (Healthy Volunteers) so that
you can see the ClearTrial-default work breakdown structure in one report for the cost
model specified.

Plan Reporting Enhancements
In addition to the Plan Summary report enhancements included, 5.8.5 offers a new
plan comparison report and updates to the existing reporting available “out-of-the-box”.

Compare Responsibilities

A new comparison report to compare responsibilities by location for tasks and costs,
across multiple plans with the capability to only show differences has been added.

Select multiple plans from the Plan List screen > Click Compare, Compare
Responsibilities > Only Show Differences, to easily identify the changes in
responsibilities to a plan, contract or change orders.

Assumptions Report Enhancements

Meetings assumptions are now displayed on the Plan Assumptions report.

Name, type, location, frequency and number of meetings are included so that you see
all the plan assumptions in one report.

If you want to drill down further into individual meetings, you can run the Plan Meetings
report.

Both reports are available from the Plan Reports tab.

Transparent Subscription Status/Usage Reporting
Planned Trials reporting has been improved for all users to continuously monitor and
track your organization’s usage against subscription quotas.

Launched from Report > Planned Trials, the Planned Trials report provides you with a
single view into your organization’s usage, over time.

As a ClearTrial best practice, we recommend running this report to manage and
monitor compliance per month during your subscription duration.

This release also includes notifications that may appear when creating or editing a
study or plan, to inform you of your subscription status, when you are close to
exceeding subscribed limits, so that you know when to contact your Account
Representative to increase your quotas.

Chapter 1
Plan Reporting Enhancements
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Best Practices
As with every update, we are keen to offer the ClearTrial recommended best practices to
ensure you are most effective in your usage and budgeting operations.

• Lock your plans before sending out budgets to contract, when you are satisfied with
your final operational budget forecast and to prevent assumption values from being
changed.

• Freeze billing rates to ensure existing rates are preserved in copies of locked plans or
anytime you are satisfied with your operational budget forecast.

Chapter 1
Best Practices
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2
Changes in Update 5.8

Release 5.8 brought new and enhanced capabilities to the Oracle Health Sciences ClearTrial
Plan and Source Cloud Service, providing increased flexibility, transparency, and efficiency in
your study planning and outsourcing.

This software update included a new ClearTrial 5.8 Cost Model to which you should upgrade
existing plans and user-defined templates to leverage the latest industry standard costing
algorithms.

• Technical Requirements

• Best Practices

• Clinical Intelligence Update

• Usability Enhancements

• Plan Reporting Enhancements

• RFP and Service Work Order Process Flows (Enterprise Edition)

• New Bid Grid Formats for RFPs (Enterprise Edition Sponsors)

Technical Requirements
Important Reminder: As of Release 5.7, ClearTrial no longer operates with versions of
Microsoft Internet Explorer for which Microsoft has ended support. Please upgrade to a
currently supported version of Microsoft Internet Explorer (11 or Edge) or, as
recommended, use Google Chrome to access the service. For more information on
ClearTrial's minimum and recommended configurations, please visit the latest version of the
Technical Requirements, available on the Oracle Help Center.

Best Practices
As with every update, we are keen to offer the ClearTrial-recommended best practices to
ensure you are effective in your usage and budgeting operations.

• Lock your plans before sending out budgets to contract, when you are satisfied with your
final operational budget forecast, and when you need to prevent assumption values from
being changed.

• Freeze billing rates to ensure that existing rates are preserved in copies of locked plans,
or anytime you are satisfied with your operational budget forecast.

• Upgrade existing plans and user-defined templates to the latest available Cost Model.

Why? Upgrading plans and user-defined templates to the latest Cost Model ensures you
are working with the latest updates to fees and costs included in both the ClearTrial-
defined Work Breakdown Structure (WBS) and default indirect (pass-through or
miscellaneous) cost calculations.
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Note:

Existing plans and user-defined templates are not automatically
upgraded with each update that includes a new Cost Model.

Upgrading Existing Plans/Templates to the Latest Cost Model

If you need to determine the impact of upgrading existing plans or user-defined
templates to the latest Cost Model, follow the steps below to quickly assess the impact
to the budget.

1. From the Plan or Template list screen, copy the existing plan/template that you
want to upgrade.

2. Update the Cost Model of the copy.

a. Select the copied plan/template.

b. Click Other Actions... and select Change Attributes.

c. In the Change Plan Attributes dialog, select 5.8 from the Cost Model drop-
down list.

d. Click Save & Close.

3. From the list screen, select the original and its copy, and click Compare to run the
comparison reports.

Impact of Unlocking a Plan Using a 5.2 or Prior Cost Model

When you unlock or copy an existing plan using a 5.2 or prior Cost Model, that plan
will default to the latest available Cost Model.

Clinical Intelligence Update
MOH/FDA Delay Default Updates

Release 5.8 has been enhanced with updated MOH/FDA Delay Defaults effective for
2018.

ClearTrial continuously monitors the regulatory landscape to provide the latest industry
observed Ethics Committee and Regulatory application processing delays. The
observed changes are represented by the new MOH/FDA Delay Defaults in the
application. The following supported countries and economically grouped regions have
updated MOH/FDA Delay Defaults in 5.8:

• Asia (CT-defined economic region)

• France

• Portugal

• Russia

• Spain

• Thailand

Chapter 2
Clinical Intelligence Update
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The updates to these location-specific defaults only impact new plans using the 5.8 Cost
Model or if new locations are added to existing plans, unless you are importing the location-
specific overridden MOH delay value from another plan/template.

Updated Default Cycle Times

The default number of days in the Timelines section of the Plan Data tab have been updated
to align with industry standard timelines. These include the following assumptions which vary
by study phase and data collection method:

• Days from LSO/LPO until Database Lock

• Days from Database Lock until Statistical Report due

• Days from Database Lock until Draft Report due

• Days from Database Lock until Final Report due

Default Data Management and Data Entry Labor Update

The 5.8 Cost Model brings reorganized data entry and data management tasks to better
separate and distinguish tasks that are not applicable when EDC is being used. These
updates will be seen in plans using the 5.8 Cost Model.

Usability Enhancements
The updates in this section improve on ease of use, maximize efficiency, and give you a more
efficient user experience with ClearTrial.

Power User Role Permissions Update (for Assigned System Administrators)

Release 5.8 makes the permissions to create studies optional for those users who are
assigned the Power User primary role. Existing users who are assigned the Power User role
will have this permission enabled/selected by default, but any new users assigned the Power
User role will not be able to create studies by default; your assigned ClearTrial System
Administrator can grant this permission.

Monitoring Assumption Update

The existing Other hours onsite per visit monitoring approach assumption, introduced in
Release 5.7, has been renamed to Other (Non-SDV) hours onsite per visit in Release 5.8
to be more explicit.

When included in your 5.8 Bid Grid, this specification is called Non-SDV hours per visit for
consistency in the Specifications worksheet.

Cost Model Display on Plan List Screen

The Cost Model version per plan will be displayed by default on the Plan List screen so you
can easily identify existing plans using a prior Cost Model eligible for upgrade.

Chapter 2
Usability Enhancements
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Note:

The option Configure List Options, located in the upper right on all list
screens, gives you the flexibility to select which data columns you want
displayed on the list screen.

Choose the Cost Model for New Plans

When creating a new plan from a user-defined template, there is a new option to
change the Cost Model for the plan.

Plans created from user-defined templates will default to the latest available Cost
Model.

Note:

New plans created from the ClearTrial-defined template will always use the
latest available Cost Model by default.

Specify Custom Fields as Boolean Type (for Custom Fields Designers)

Note:

Additional roles/capabilities are required for creating custom fields and
custom field models. Custom Fields Designer—This additional role grants
permissions required to create, edit, view, and delete custom fields within the
DRAFT custom field model and to check-out, check-in, and publish the
DRAFT custom field model.

For those Custom Fields Designers creating custom fields to use as variables in
scripted algorithms in a plan, there is now a new data type to choose from for a
custom field type: Boolean. This type of custom field can be used when you are
defining variables where the values are yes or no (or any other affirmative or negative
response up to 8 characters). For example, for your custom scripted algorithm, if the
scripted variable's value is yes, perform this specific calculation. Else, if the custom
field value is no, perform a different calculation.

Manage your Notifications in Real Time

Easily manage your notifications in real time when you edit your user profile, launched
by clicking on your name in the upper right hand menu bar and clicking Edit Profile.
You will see two new options selected by default to receive service notifications going
forward, including future release announcements or the ability to provide your input in
any surveys we conduct.

Chapter 2
Usability Enhancements
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Plan Reporting Enhancements
ClearTrial 5.8 continues to increase flexibility and expand on the enhancements provided in
Release 5.7 and includes updates to generating the Milestone Dates and Milestone Payment
Schedule reports.

Milestone Dates Report

The Milestone Dates report has been enhanced to align with the milestones excluded on the
Payments tab of a plan. When you click on the Milestone Dates report link from the Reports
tab of a plan, 5.8 opens a new input screen for you to select and verify which milestones to
include or exclude in the report from the list of milestone payments.

• Included milestones from the Payments tab of your plan are selected by default.

• Excluded milestones from the Payments tab of your plan are deselected by default.

• Days Since Last, introduced in Release 5.7, will calculate based on the last included
milestone you have chosen to include in the report.

Milestone Payment Schedule Report (Enterprise Edition users)

The Release 5.8 Milestone Payment Schedule report includes new reporting options to
include milestone payments with no or zero amount and whether to show or hide excluded
milestones in the report.

RFP and Service Work Order Process Flows (Enterprise
Edition)

Figure 2-1    RFP and Revision Process using Excel Import

Chapter 2
Plan Reporting Enhancements

2-5



Figure 2-2    RFP, SU SWO, SWO Process using CT

New Bid Grid Formats for RFPs (Enterprise Edition
Sponsors)

The Sponsor workflow from planning through vendor selection in outsourcing can be
arduous, time consuming, and costly, but ClearTrial 5.8 streamlines your existing
insular benchmarking and contracting processes in one place.

With 5.8, outsourcing/procurement users can manage and maintain benchmark plans,
RFPs, and vendor bids in one place, to efficiently compare apples to apples and to
centralize all your historical data in one place so that you gain actionable insights.

When creating an RFP and generating a Bid Grid in 5.8, there are new options to
select from to give you direct control over the data included and format required to
receive quality bids from vendors.

Generating the RFP's Bid Grid from a plan can be launched by multiple ways or
locations in the service.

1. Select an existing RFP from the RFP List screen launched by selecting RFPs from
the Edit menu.

a. Click New from the RFP List screen.

b. Choose the plan from which you want to create the RFP.

Chapter 2
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In the Create RFP dialog there is a new option that is selected by default: Download
Bid Grid.

2. Select an RFP from the RFP List screen and click the Download Bid Grid button.

3. Select an RFP from the RFP List screen and click Edit.

On the Details tab, there is a Download Bid Grid link towards the bottom of the page.

4. Selecting a plan from the Plan List screen and clicking Create RFP from the Other
Actions… menu.

a. In the Create RFP dialog, fill in the required information and then you will see a new
option selected by default: Download Bid Grid.

b. Keep that option selected and click Continue… to see the new Download Bid Grid
dialog where you will be able to select from various options to control the level of data
and default contents included in the Bid Grid.

Note:

Additional roles/capabilities required for RFPs and bids management

• Users who have the RFP Administrator additional role/capability granted can
create, edit, or delete RFPs.

• Users who have the RFP/Bid Reader additional role/capability granted can
view RFPs and bids.

Your assigned ClearTrial System Administrator can configure these for you and any other
user permissions, on demand.

Specify Bid Grid File Name when Creating an RFP or Later

In 5.8, when you create an RFP from a plan, you will be prompted to enter the Bid Grid File
Name, which is a user-defined file name that you set to use when you export your Bid Grid
workbook. You can also change this filename after the RFP has been created, at any time, by
editing the selected RFP from the RFP list screen and navigating to the Details tab.

New Download Bid Grid Dialog

Upon downloading the 5.8 Bid Grid, there are several new options available to control the
format and contents of the Bid Grid you send to vendors. Additionally, you now have direct
control over the values your vendors can submit to ensure you are receiving quality bids and
reducing time on comparisons.

New options to specify the level of detail included: You can now choose from three levels
of data granularity for the activities included in the Bid Grid.

• Major Task/Cost (highest level)

Note: The Bid Grid will always contain, at a minimum, Major Task/Cost level data.

• Major Task and Task

• Major Task, Task and Resource (lowest level)

New options to specify location options: 5.8 allows you the flexibility to generate a global
Bid Grid on a single worksheet or to include a worksheet for every location.

Chapter 2
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• Global

• Per Location

New options to specify what vendors are to submit: You have several choices to
control which data you want vendors to submit back in their bids.

• Unit Hours or Total Hours

• Unit Cost or Total Cost

• Resource Billing Rate

Note: The resource Billing Rate option is only enabled when you are generating
the Bid Grid at the lowest level of granularity (by Major Task/Cost, Task, and
Resource).

If you want your vendors to edit the number of units per major task, then generate the
Bid Grid with Major Task/Cost detail selected and either at a global level or by location.
You will see the Number of units cells highlighted in blue in the Bid Grid-specific
worksheets.

Note:

All blue cells in the Bid Grid are editable by vendors.

The options selected when generating the Bid Grid will determine which fields are blue
in the Bid Grid workbook. For example, if you want vendors to provide the total hours
and total cost for each line item, then you can change the ClearTrial default to total
hours and total cost for the vendor editable values and you will see the total hours and
total cost cells with a blue background color in the Bid Grid. Blue is to indicate to your
vendors which fields they are able to enter and edit.

Additional sheets to include: Specifications, Responsibilities Matrix, and Timelines
worksheets will be selected and included by default in your Bid Grid.

Don't worry! ClearTrial 5.8 will remember the options you selected last time you
generated the Bid Grid, so you don't have to.

Enhanced Default Bid Grid Structure

After you have downloaded and opened the ClearTrial default Bid Grid from a specific
plan, you will see multiple sheets included in the excel (.xls) workbook, depending on
the options selected, each of which you will want to review before sending out to
vendors.

Instructions: The first sheet included will offer the default instructions for vendors to
understand how to enter and complete their bid successfully.

Note:

If you want to change the default Instructions included, you can simply delete
this sheet and insert a new custom sheet for the custom instructions you
want to provide to your vendors.
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Specifications: When included, this sheet provides you the default study specifications from
the study plan you created your RFP from. This sheet is editable to allow you the upmost
flexibility to change the format or data included based on the specific needs for your study or
to align with your already established business processes and standards.

Note:

Please make sure you enter in your Sponsor contact information at the top of this
sheet in the space provided before sending out for bid.

If you have configured custom fields in your plan using the custom assumptions feature, all
custom fields will be located at the bottom of this sheet, so that you can easily remove them if
needed.

The "- -" is displayed as the Total value for specifications where the global value is not
calculated as a summation.

Responsibilities Matrix: When included, this sheet provides you the default activity
ownership matrix for all included tasks in the study so there is no confusion between who is
assigned to do the work between you, your CRO and if applicable, other vendors.

This sheet is editable in case custom updates need to be made and is filterable so you or
your vendor can quickly hone in on your assignments only.

Timelines: When included, this sheet will contain the study activity milestone date schedule.

The Study Duration displayed at the bottom is calculated from the time between the first and
last included milestone. The comments column in blue allows vendors to add any comments
for alternative dates or anticipated timeline changes.

Summary: The BidGrid_Summary sheet included provides you the ability to export and view
summary bid data in a comprehensible format for inclusion in your contracts.

This sheet will include a blue cell for each vendor to enter in their name which will cascade
onto the other subsequent sheets.

Note:

The vendor name is required for each vendor to enter before you import the
completed bid or you will receive a fatal error upon import of the completed bid grid.
The vendor name will be associated with the bid version upon import of the bid in
ClearTrial.

Additionally, there is a blue cell offered for vendors to enter in a bottom line discount off of the
total labor fees.

Global: The BidGrid_Global sheet included provides your vendors the ability to enter their
proposed hours and costs for effort being performed in the back office or not being performed
in a particular location.

Per Location: The BidGrid_<plan location name> sheets will include those tasks that are
being performed in a specific location and indirect costs that vary by location. There will be a
single sheet included per location.
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Editable Mapping Key: The mapping key was initially offered in ClearTrial 5.3 in the
Bid Grid to allow your vendors a quick way to map back to their client grids. In 5.8, the
mapping key is editable so your vendors can efficiently update the ClearTrial default
value offered per line item to align with their existing mapping identifiers.

Important Bid Grid Considerations

1. All bids uploaded must be in .xls format only. Any other format will cause upload
errors.

2. You cannot delete or alter the structure of any of the BidGrid_global or by location
sheets in the workbook.

For example, deleting or adding columns to these sheets are not permitted and will
result in errors when you upload the bid into ClearTrial.

3. Blue cells in the workbook are those cells which your vendors can edit and will
vary depending on the options selected when generating the Bid Grid.

4. Vendor editable comments support up to 2500 characters in the Bid Grid_global/by
location sheets so vendors can add alternate scenarios or their assumptions when
completing their bid.

5. Number of units is editable for your vendors, when you generate the Bid Grid at
the Major Task/Cost, global or by location levels.

Vendors can enter or edit the Number of units provided in whole number values.

6. You can insert any custom sheets you wish to include in your workbook, in any
particular order.

7. If you would like to edit or replace the default Instructions, Specifications,
Responsibilities Matrix and Timelines included in the workbook, delete the sheets
and insert your custom sheets into the workbook.

8. If you do not want assigned items included in your RFP/Bid Grid, remember to
exclude them from your plan before generating your RFP.

9. All included, assigned line items which result in zero value (tasks/indirect costs
calculated as zero) or are adjusted to zero will be included in your RFP/Bid Grid so
you can solicit a cost you don't know and want vendors to bid on.

If you don't want costs or fees that have no expected effort or amounts to be
included in the Bid Grid, you can exclude them from the plan or remove their
assignments. If fees/costs with zero amount are not assigned to the provider for
the scope of work for your RFP, they will be excluded from the Bid Grid.

10. Major Task, Task and Resource must be included in the plan for the data to be
included in the Bid Grid.

If you run the Bid Grid by Major Task and your major task has no included tasks,
the major task will be excluded from the Bid Grid.

Major tasks with no tasks or with only tasks with no resources are excluded from
the Bid Grid.

11. If you zero out meeting attendees or set the number of attendees for a particular
resource type to zero from the Meetings Manager of a plan, those meetings line
items are excluded from the Bid Grid.
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Import Vendor Submitted Bid Enhancements

After you have received a submitted bid from a vendor for your RFP, navigate to the RFP list
screen and for that selected RFP, click on Import Bid. ClearTrial 5.8 will automatically
associate the vendor name provided on the Bid-Grid_Summary sheet by the vendor in the
completed Bid Grid to the specific bid being imported. If a bid already exists from that vendor,
you can still choose if you want to replace the existing version or create a new bid version for
that vendor.

Bids Comparison Enhancements (Enterprise Edition Sponsors)

5.8 offers you the flexibility to compare up to 5 items at any given time, where a bid compared
against the planned values count as 2 items.

For example, you can compare up to 4 bids against your benchmark's planned values or
compare 5 bids, where you can select which bid you want to be the baseline for comparison.

Tip:

Tip: Compare bids can be launched from multiple locations/workflows in the service.

You can compare bids in the following ways:

1. Select an existing RFP from the RFP List screen from Edit > RFPs (launched by selecting
RFPs from the Edit menu).

a. Click Compare Bids to compare all the bids imported by vendor and version number
for that RFP.

ClearTrial assumes that you want to compare all bids for this RFP. If you want to limit
your comparison to specific bids for this RFP, access the comparison from the Bid list
screen (see option 2 below).

Note:

You can compare bids for an RFP that has existing bids uploaded. To easily
identify which RFPs have bids imported against them from the RFP list screen,
click on the Configure List Options link and ensure you have selected
Number of Bids as a column to display.

2. Select multiple bids from the Bids List screen from Edit > Bids (launched by selecting
Bids from the Edit menu).

a. Click Compare.

View Bids from RFP Bids Tab

When you edit an RFP from the RFP list screen, if you navigate to the Bids tab, you will see a
new button in 5.8 to view the bid directly from this screen without having to go back to the Bid
list screen and locating the specific bid for the RFP.
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Vendor Bid Comparison Options

When configuring the reporting parameters for comparison, you can choose the level
of granularity, which values to compare and whether or not to highlight variances
above the user-defined threshold specified for costs and hours.

Available options to select depend on the granularity of bids selected for comparison.
By default, bids are rolled up to the corresponding common lowest level of granularity.

• Level of Comparison: Select the level of data for the comparison. Major Task is
selected and disabled by default since this high level activity is static in all Bid Grid
formats. If the bids selected include data at the task-resource level, those options
will be available to choose from for values comparison.

• Location Options: If one bid is global and the other bid is by location, global will
be selected by default because comparisons can be done at their most common
level.

• Values to Compare: Select all the data points you want included for the bids
comparison. For all comparisons conducted, the total cost will always be selected
and included and the number of units will be selected by default.

• Variance Display: Specify whether or not you want to highlight costs and/or hours
variances beyond a user-defined (positive/negative) percentage threshold or
tolerance.

• Baseline for Comparison: Select to include the Planned Values or a specific bid
as the baseline, if you are comparing multiple bids. If you are comparing a single
bid to the benchmark's planned values, then the planned values will always be
included in the comparison and selected.

You can also click on the blue question mark icon in the upper right hand side of the
dialog in real time for more information directly from the UI.

Important Bids Comparison Considerations

1. Default for comparing bids is excel (.xls). CSV is not supported for bids
comparison reporting.

2. If you need to store the comparison report for historical data purposes or records,
when exporting to PDF, zoom your document to 100%.

3. The baseline item appears first in the report, whether that be the benchmark's
planned values or the bid chosen as the baseline for comparison against other
bids.

4. When specified, cost value variances greater than the user-defined threshold, are
highlighted in yellow.

5. Hours value variances, when specified, are highlighted in blue to easily distinguish
between the two types of variances in the report.

6. The specified user-defined thresholds for costs and hours, depending on what you
have selected to highlight is explicitly displayed in the report output so you can
easily identify what the % was when reviewing the report at a later time.

7. Use the bid mapping table located at the top of the report to identify each bid by
plan name, vendor name, version of the bid and its description.

8. For comparison ease-of-use in Excel, when comparing multiple bids and/or
including planned values, beneath the bid mapping table provided:
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a. Select the row under the column headers where Bid 1, Bid 2, and so on is displayed.

b. From Excel's View menu, Window options, select Freeze Panes to freeze that row
while the rest of the worksheet scrolls. This makes it easy to identify the items for
further review or decisions.
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3
Changes in Update 5.7

5.7 brings new and enhanced capabilities to Oracle Health Sciences ClearTrial Plan and
Source Cloud Service for increased accuracy, flexibility, efficiency, and transparency for your
study planning, forecasting, budgeting, and outsourcing needs.

This update also includes a NEW ClearTrial 5.7 Cost Model. Upgrade your plans and user-
defined templates so that you can take advantage of the latest costing algorithms.

• Technical Requirements

• Best Practices

• New Oracle Help Center

• Clinical Intelligence Update

• Increased Transparency into Monitoring Efforts

• Reporting Enhancements

• Usability or Efficiency Enhancements

• Enhancements for Increased Precision & Accuracy for Precise Budgeters

• Improved Contract Alignment and Change Order Support (Enterprise Edition Only)

• Import Additional Location-specific Overrides from a Plan or Template

• Custom Algorithms and Custom Fields Validated for Calculation Errors

• New Duration-based Variables for Custom Algorithms using Script

• Updates to the Web Services API (Enterprise Edition only)

Technical Requirements
Important: ClearTrial 5.7 no longer operates with versions of Microsoft Internet Explorer for
which Microsoft has ended support. Please upgrade to a currently supported version of
Microsoft Internet Explorer (11 or Edge) or, as recommended, use Google Chrome to access
the service. For more information, see the Oracle Software Web Browser Support Policy.

5.7 also includes an update to the minimum Screen Resolution or Size to 1366 x 768 pixels.

For more information on ClearTrial's minimum and recommended configurations, please visit
the latest version of the System Requirements, accessible from the new Oracle Help
Center.

Best Practices
As with every update, we are keen to offer the ClearTrial recommended best practices to
ensure you are most effective in your usage and budgeting operations.

• Lock your plans if you do not want users to change any assumption values you entered.

• Freeze billing rates anytime you are satisfied with your operational budget's forecast.
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• Upgrade existing plans and custom templates to the latest cost model that
ClearTrial offers.

Why? Upgrading plans and user-defined templates to the latest cost model
ensures you are working with the latest updates to fees and costs included in both
the ClearTrial Work Breakdown Structure (WBS) and indirect (pass-through or
miscellaneous) cost calculations. Existing plans and user-defined templates do not
automatically get upgraded with each update that includes a new, available cost
model.

• Upgrading to the 5.7 Cost Model

Upgrading to the 5.7 Cost Model
Evaluate Cost Model impact to plans or templates to determine the impact of
upgrading existing plans or user-defined templates to the latest cost model, follow
these steps to quickly see the impact to the budget:

1. From the Plan or Template list, copy the existing plan or template you want to
upgrade.

2. Update the cost model of the copy:

a. Select the copied plan or template.

b. Click Other Actions... and select Change Attributes.

c. On the Change Plan Attributes dialog, select 5.7 from the Cost Model drop-
down list.

d. Click Save & Close.

3. From the list screen, select the original and its copy, and then click Compare to
run any of the comparison reports.

New Oracle Help Center
What's changed? The existing, embedded ClearTrial Support Center has been
replaced with the new Oracle Help Center. The Oracle Help Center is accessible
from the same locations within the service as used today.

• Next to your name in the upper right menu, click on the Visit Oracle Help Center
link.

• From the Help menu, select Launch Oracle Help Center.

The Oracle Help Center offers various service-specific multimedia content and based
on your needs.

• Get Started: Activity-directed content and resources, including what's new in the
service.

• Videos: Goal-directed educational videos that will help you learn how to use the
service.

• Books: User guides and Release Notes.

• Search: Identify and find the specific information you need. Use the search bar at
the top of any screen to search the entire documentation library, or use the search
bar on the left while browsing a book to search within the current book.
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Clinical Intelligence Update
As part of the ongoing commitment to maintain industry-standard algorithms, ClearTrial
continuously performs a detailed analysis of our embedded clinical intelligence to ensure that
we are aligned with the latest industry standards and trends.

• MOH/FDA Delays Update

• Work Breakdown Structure (WBS) Update

MOH/FDA Delays Update
What's changed? The Ministry of Health (MOH) or FDA Delay per location defaults have
been updated to be aligned with the latest updates to global regulatory authority review times
per country.

This includes an update to the default MOH delay per ClearTrial-defined region to use the
median value across all countries under each economic region.

22 out of 98 ClearTrial supported locations have been updated.

Work Breakdown Structure (WBS) Update
This update includes various updates to the ClearTrial-defined WBS. In summary, the
following updates are included in the ClearTrial 5.7 Cost Model.

• Introduction of the Lead CRA resource.

• Updated Major Tasks, Tasks, and Resources.

• Updates to defaults for ClearTrial-defined assumptions and level of effort calculations.

• New units of measure and cost drivers.

• A new 5-task structure for all site visit algorithms including Pre-study Site Visit (PSSV),
Site Initiation Visit (SIV), Interim Monitoring Visit (IMV), and Site Close-out Visit (COV).

The following ClearTrial-defined Major Tasks and Tasks have been added or renamed in the
5.7 cost model:

Table 3-1    Added or Renamed Major Tasks

5.6 Major Task Name 5.7 Major Task Name

Site Audited Quality Assurance - Site Audit

Pre-study Site Visit (PSSV) Pre-study Site Visit

Pre-study Site Visit (PSSV) by Phone Pre-study Site Visit by Phone

One Hour of Phone-based Monitoring Phone-based Monitoring Visit

Onsite Monitoring Visit - Prep, Travel, Reporting,
and Follow-up

Onsite Monitoring Visit - Non-SDV Activity
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Table 3-2    Updated Tasks, by Major Task

5.6 Task Name 5.7 Task Name

Pre-study Site Visit Pre-study Site Visit

(None) Pre-study site visit - Trip Report Review

Pre-study Site Visit by Phone Pre-study Site Visit by Phone

(None) Complete phone-based pre-study site visit Trip
Report Review

Site Initiation Visit Site Initiation Visit

(None) Site initiation visit - Trip Report Review

Site Initiation Visit by Phone Site Initiation Visit by Phone

(None) Complete phone-based site initiation visit Trip
Report Review

Onsite Monitoring Visit - Prep, Travel,
Reporting, and Follow-up

Onsite Monitoring Visit - Non-SDV Activity

(None) Onsite monitoring visit - Trip Report Review

(None) Onsite monitoring visit - Perform other onsite
activities

One Hour of Phone-based Monitoring Phone-based Monitoring Visit

Perform phone-based monitoring visit Complete phone-based interim monitoring visit

(None) Complete phone-based interim monitoring visit -
Trip Report Review

Separate Drug Accountability Visit Separate Drug Accountability Visit

(None) Prepare for separate drug accountability visit

(None) Travel to site to perform separate drug
accountability visit

(None) Follow-up for separate drug accountability visit

Site Audited Quality Assurance - Site Audit

• Conduct pre-audit discussions with
clinical, regulatory and sponsor

• Travel to and from study site for audits
• Obtain and review investigator file

documents for audits
• Write the audit report
• Review final audit report
• Conduct post-audit discussions with

clinical, regulatory and sponsor

• Site Audit - Preparation
• Site Audit - Travel
• Site Audit - Onsite Time
• Site Audit - Reporting/Follow-up
• Site Audit - Report Review by Mgmt

Site Close-out Visit Site Close-out Visit
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Table 3-2    (Cont.) Updated Tasks, by Major Task

5.6 Task Name 5.7 Task Name

• Conduct final onsite visit - Preparation
• Prepare site close-out monitoring report
• Complete drug reconciliation/

accountability/return
• Review all regulatory documents
• Close out EDC
• Collect the investigator study report
• Return and/or ensure destruction of

study drug
• Ensure close-out report issued to

sponsor

• Conduct final onsite visit - Preparation
• Conduct final onsite visit - Travel
• Conduct final onsite visit - Onsite Time
• Conduct final onsite visit - Reporting/

Follow-up
• Conduct final onsite visit - Trip Report

Review

Site Close-out Visit by Phone Site Close-out Visit by Phone

Conduct final site visit (via phone) Conduct final site close-out visit (via phone)

(None) Conduct final site close-out visit (via phone) Trip
Report Review

WARNING:

Before upgrading or copying any plan from a prior cost model, please make sure
you have not created any custom Tasks or Major Tasks with the same name as
those included in the 5.7 Cost Model. If you have, please remove or rename these
prior to upgrading or copying those plans.

Updates to Units of Measure and Cost Drivers

• The unit for the Phone-based Monitoring Visit major task has changed from Hours to
Phone IMV.

• The following new units of measure or cost drivers are available to leverage when
defining custom algorithms:

– Month

– Day

– Phone PSSV

– Phone SIV

– Phone IMV

– Phone COV

Updates to Resources

• Existing QA01 - Compliance / QA Manager has been updated to QA01 - Quality
Assurance Manager

• Existing QA02 - Compliance / QA Auditor has been updated to QA02 - Quality
Assurance Auditor
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• New CR09 - Lead CRA resource is included by default on all new visit-specific trip
report review Tasks.

New Paradigm for Site Visit Labor

The Major Tasks listed below have been updated to use a 5-task pattern for the
various activities performed for each visit. This includes preparation, travel, reporting/
follow-up, onsite time and trip report review activities included by default under each
type of site visit Major Task.

Increased Transparency into Monitoring Efforts
What's changed? The existing effort calculated for the "Monitored, Clean CRF Page"
Major Task has been broken out into two distinct Major Tasks and Tasks to account for
SDV and non-SDV related activities.

Existing 5.6 Major Task, "Onsite Monitoring Visit - Prep, Travel, Reporting and Follow-
up" has been updated to "Onsite Monitoring Visit - Non-SDV Activity" and includes two
additional Tasks for other onsite time and trip report review activities. Two new Tasks
include the following:

• Onsite monitoring visit - Perform other onsite monitoring activities

• Onsite monitoring visit - Trip Report Review

The new Task for other time onsite is driven by a new "Other hours onsite per visit"
assumption located on the Monitoring tab of your plans. This field allows you to specify
the number of hours expected during each visit to perform activities not directly related
to source document verification.

Separate Drug Accountability Visit Updates

To more accurately account for the various activities under the existing Separate Drug
Accountability Major Task, the following Tasks have been added:

• Prepare for separate drug accountability visit

• Travel to site to perform separate drug accountability visit

• Follow-up for separate drug accountability visit

Default hours for the selected resource performing work on the existing ClearTrial-
defined Task, Perform Separate Drug Accountability Visit has also been updated.

Monitoring Visit Time Calculation Update

The monitoring time per visit calculation has been updated to use the same Minutes
per CRF Page value for the baseline visit and all interim visits.

Reporting Enhancements
ClearTrial 5.7 brings various enhancements to the out-of-the-box reporting capabilities,
and offers extended configurability and control to create and build the reports you
need, on demand.

• Compare Templates

• Enhanced Summary Grid Report

• Resources by Department and Resources by GL Code Reports
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• User Report

• Fixed Unit Prices Report

• Pass-Through and 3rd Party Costs Report

• Milestone Dates Report

• Capacity Planning Reports

• General Formatting Enhancements

Compare Templates
What's new? The ability to compare templates, akin to how you compare plans, to quickly
assess the impact and differences between multiple templates.

How do I compare templates?

1. From the Templates screen, launched from Maintain > Templates, select the templates
you want to compare.

2. Click the Compare button.

Enhanced Summary Grid Report
The Summary Grid report looks and works better than ever. With extensive configurable
reporting parameters, you can create the type of Bid Grid report required by your vendors or
effectively replace your existing internal vendor selection tools and processes to have them
reside alongside other planning and contracting data, in a single data source.

Managing Bid Grid reports outside of ClearTrial can be costly by creating multiple disparate,
interoperable sources of data making it harder over time to harvest to drive insight.
Leveraging ClearTrial for both your study budget planning, forecasting, outsourcing and
contracting (including bid grid reporting), offers one single, secure, traceable repository to
harvest all your trial data over time.

New name: The Summary Grid by Major Task report launched from the Reports tab of your
plan has been renamed the Summary Grid report

New reporting groupings: This summary level plan report will always include data at the
Major Task level, with the flexibility to choose from a list of available groupings for which you
want to group by in the report. This includes grouping data by Provider, Location, Major Task
or Cost, Task and Resource.

Configurable sort order: Ability to configure the sort order of the data groupings displayed
in the report output.

New option for multiple provider selection: Akin to other ClearTrial-defined reports, in the
new Providers to Include section, you can now select multiple or 'All Providers' from the list of
providers in your plan.

New rollup options: Two new options, Rollup provider level data and Rollup location level
data, to rollup data across All Provider' or across All Locations.

Changes to pre-populated data options: With one click, you can quickly and easily
generate a populated grid with all values for hours or costs based on the levels of data you
selected to display or create a blank grid to start with.
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New option Include inflation: Use this option to include or exclude inflation in the
report. If inflation is included, you will see an explicit note displayed at the top of the
report to indicate that inflation was added, in case you have to revisit the report at a
later time and can't remember what you selected when you ran the report.

New option Include zero hours/costs: If you want to obtain the same report
structure, select this option so that all hours and costs including those that are set or
calculated as zero, are displayed in the report.

New option Include excluded tasks/costs: If you want to obtain the same report
structure, i.e., have the same number of line items each time you run this report, select
this option to include tasks or costs that were excluded from the plan at any stage of
your budget cycle. Selecting this option dynamically selects and disables the include
zero hours/costs option in the report.

Note:

Any calculated or existing fees for tasks which have been excluded will be
associated with the last assigned provider for that task.

New flat-file format for Excel analysis: If you intend to use this report to feed data
visualization programs or to create pivot tables with as little manipulation required, this
option creates a flat-file format that is suitable for offline excel analysis. This format
includes exclusive updates including non-merged cells per data point and updated
header data, so you can easily insert this report into your Statement of Work (SOW) or
RFP Bundle.

Resources by Department and Resources by GL Code Reports
New options to include indirect costs: You have the flexibility to include or exclude
all indirect (pass-through or miscellaneous) costs or include only those indirect cost
items specified to be included in the report from the Costs tab of your plan.

New options to include or exclude resources with no hours and costs with no
amount: These items were previously excluded from the two reports automatically.
The ability to include these items in reports is useful if you're interested in generating a
report with the same number of rows and columns each time. With a consistent report,
you can set up templates or Excel formulas to help you work better with these reports
outside of ClearTrial.

Updated column and new column: The # Units column used to display both the
value and unit of measure. Now it strictly includes a numeric value so that, in Excel,
you can use this column for calculations. The unit of measure is now displayed
separately in the new Unit column directly to the right of # Units.

In the XLS format of the report, cells with no value no longer contain N/A, instead
they are blank to allow for use of formulas.

User Report
What's new? Launched from the Report menu of your plan, the existing User Report
has been updated to include users whose account has been deleted and displays the
created and deleted dates for auditing purposes.
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Continuous user account governance by ClearTrial System Administrators is recommended
to effectively manage all users at any given time, for your organization. This can be done
easily with the existing ClearTrial-defined Plan Inventory Report and the updated User
Report.

Fixed Unit Prices Report
What's changed? The Fixed Unit Prices report has been enhanced to give you a more
refined and cleaner output that is easier to read.

New option to include estimated start, end dates and duration: You have the upfront
flexibility on the report input screen to include the start date, end date and duration per Major
Task, so you don't have to delete these data points each time you run the report, if they are
not needed.

Eliminated redundant data display: The Number of Units, which each task inherits from its
Major Task, and the Unit of Measure display has been consolidated into single, adjacent cells
in the Major Task subtotal row.

Pass-Through and 3rd Party Costs Report
• New option to show inflation on a separate line: Displays inflation as a separate line

item in the report.

• New option to include estimated dates for costs: To exclude existing timeline details
per cost, you have the flexibility to choose if you want to include the cost start date and
cost end date, instead of having to remove them manually each time from the report
output.

Milestone Dates Report
A new column, Days from Last, has been added to the right of each milestone date, which
displays the number of days from the last milestone so that you can easily insert this report in
your SOW or RFP Bundle to provide an overview of the timeline and key progress points.

Capacity Planning Reports
The Resource Name and Resource Code sometimes concatenated in the UI are displayed in
separate columns instead of being merged so you have quick, easy access to each data
point from a single cell. You will see this update in the following reports when you select the
Format for Excel Analysis option:

• Resource/FTE Demand Summary

• Resources By Major Task

• Resources By Department

• Resources By GL Code

• Resource Demand By Date

• Billing Rates Report

Chapter 3
Reporting Enhancements

3-9



General Formatting Enhancements
We've made several enhancements to reports to improve your use of them. Highlights
included below:

• Reports are now easier to read and scan.

• Reports exported to Excel have significantly fewer merged cells and narrow
columns.

• In PDF format, reports now print to 8.5 x 11 inches (letter paper size) by default,
without having to select a fit-to-page option.

• Data in reports now fits without wrapping, with a few exceptions.

• Introduced support to display long numeric values and long headers in full.

• Reports are now consistent with each other.

• All reports now display a timestamp to help you distinguish multiple versions of the
same report.

Usability or Efficiency Enhancements
The updates in this section improve on the ease of use, maximize efficiency and give
you a more efficient user experience in ClearTrial.

• New Customer Preferences

• Combined Billing Rate and Rates & Substitutions Tabs

• New User-defined Filter Criteria

• Assign a Code for Indirect Costs

New Customer Preferences
Launched from Admin > Customer Preferences there are new customer-level
configurations that users with the assigned ClearTrial System Administrator role can
configure for all users of the service, on demand

Combine the Unit Hours and Algorithm Tabs in Task Manager

What's changed? A new setting or preference, Combine the Algorithm and Hours
Tabs in Task Manager is available under Customer Preferences that lets you choose
if you want the tabs to appear combined or separately.

Note:

This setting is set to True (on) for CROs and set to False (off) for Sponsors,
by default.

Combining these two tabs in Task Manager lets you view, adjust, or override the
resource-specific assumptions in one place, without having to move between tabs.
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Who sees the change? Users assigned WBS Editor or WBS Manager additional role
subscribed to Enterprise Edition.

Note:

Only Enterprise Edition users have access to the Task Manager to configure the
ClearTrial-defined WBS.

Configurable ClearTrial System Administrator Contact Details Display

What's changed? Name, Phone Number and Email have also been added to the existing list
of Customer Preferences to give you the flexibility to update your administrator's contact
details, when user assignments change. These details are used to inform other users when
they have updates or issues with their user accounts. Examples include:

• In the message displayed on the login page when users are locked out of their account
and need a password reset.

• In the email messages users receive when there are any updates made to their user
account, such as new user account creation or updates to existing user account data.

This information will help users contact their administrator for immediate assistance with their
user account.

Note:

Take a moment and review the existing customer preferences set for all users and
add or update these fields, especially if your legacy ClearTrial System Administrator
has been updated to a new user at your organization.

Who sees the change? All users will see their assigned ClearTrial System Administrator's
contact information displayed when they have updates to their user account or get locked of
their account.

Combined Billing Rate and Rates & Substitutions Tabs
What's changed? Launched from Task Manager > Major Task > Task > Resource level,
you will see one combined tab or place to view and adjust a resource's billing rate location,
billing rates and substitution assumptions.

Who sees the change? Users assigned the WBS Editor or WBS Manager additional role
subscribed to Enterprise Edition.

Note:

This update does not require a customer preference setting and is applicable to all
users to maximize efficiency.
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New User-defined Filter Criteria
What's new? When you create a user-defined filter on the Plan List screen, you will
see new filter criteria to filter your plans by, including the flexibility to filter by Study
Name and Product Name, in addition to Plan Name.

You will see the following new criteria on the Define Plan Filter dialog:

• Study name starts with

• Product name starts with

You will see the following new criteria on the Define Study Filter dialog:

• Product name starts with

Assign a Code for Indirect Costs
What's new? The Code field, which used to be available for tasks only, is now also
available for costs. You can use the new Code field for indirect costs to specify a
custom code for the cost. Together with the existing Code field for Tasks, you can use
them to map tasks and costs back to your partner's grid.

The ability to provide a code and edit the mapping key are now consistent and
available for a task and indirect cost item.

Enhancements for Increased Precision & Accuracy for
Precise Budgeters

• Change Provider for ClearTrial-defined Costs

• Increased Precision for Milestone Payments

• Exclude ClearTrial-defined Milestones from Your Plan (Enterprise Edition Only)

• Override Total Number of Meetings

• Select Back Office as Billing Rate Location for Meeting Attendee

• Delete ClearTrial-defined Major Tasks and Tasks (Enterprise Edition Only)

Change Provider for ClearTrial-defined Costs
What's changed? You can edit the Provider assignment for ClearTrial-defined costs
to align to your contract.

Increased Precision for Milestone Payments
What's changed? When setting up payment terms negotiated with your service
provider on the Payments tab of your plan, you have the flexibility to enter in the
precise number of days from invoice to payment.
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Exclude ClearTrial-defined Milestones from Your Plan (Enterprise Edition
Only)

What's new? When you need to configure the milestones negotiated for your contract, you
can select a ClearTrial-defined milestone and exclude it from your plan with one-click of the
Exclude Milestone button. A new filter has been added at the top of the Payments tab of a
plan to let you show or hide excluded milestones from the milestones list.

Excluded milestones will appear distinguished in the list with strike-through font. You have the
capability to include the milestone back in your plan at any time, on demand by clicking on
the new Include Milestone button.

Who sees the change? Users subscribed to Enterprise Edition.

Override Total Number of Meetings
What's changed? On the Meetings tab of your plan, for each meeting, on the Meeting
Details tab, after you have configured the frequency, you can now override the calculated
total number of meetings to align with the precise number of meetings accounted for in your
contract.

Select Back Office as Billing Rate Location for Meeting Attendee
What's changed? On the Meetings tab of your plan, for each meeting, on the Meeting
Attendees tab, Back Office has been added to the list of values to choose from when
configuring the Billing Rate Location per attendee.

Delete ClearTrial-defined Major Tasks and Tasks (Enterprise Edition Only)
What's changed? If you need to hide any ClearTrial-defined Major Tasks or Tasks from your
plan entirely, you can permanently delete them so they don't appear in the UI or on reports.

Deleting a Task or Major Task affects only the plan you're editing; it does not delete them
from the template on which the plan is based. Once deleted from a plan, you can't restore the
Major Task or Task.

For Major Tasks, on the Labor tab, select the ClearTrial-defined Major Task you want to
delete and click Delete Major Task.

For Tasks, on the Major Task Details tab of the Task Manager, select the ClearTrial-defined
Task you want to delete and click Delete Task.

Who sees the change? Users with WBS Editor or WBS Manager role subscribed to
Enterprise Edition.

Note:

Users with the WBS Editor role can delete only their own Tasks and Major Tasks,
but users with the WBS Manager role can also delete Tasks and Major Tasks
created by other users.
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Improved Contract Alignment and Change Order Support
(Enterprise Edition Only)

What's new? Because we know plans change over time as more data is attained,
we've introduced the ability to apply incremental or floating adjustments as a way to
capture each change request, when timelines change.

At the Major Task Adjustments level and the Resource Hours level, you will see a new
column inserted between the planned or calculated value and the adjusted value to
apply a positive or negative offset, instead of overriding the adjusted value itself. You
can capture incremental changes made to planned values and keep the adjustment
separate ("floating") in case assumptions change, so it is always applied to the
updated planned or calculated value.

All applicable labor reports will also inherit the final adjustments.

Who sees the change? Users assigned the WBS Editor or WBS Manager subscribed
to Enterprise Edition.

Apply Incremental Adjustment to the Number of Units for Major Tasks

1. Go to the Labor tab for the plan.

2. Select the Major Task to adjust and click Edit Major Task.

3. Go to the Adjustments tab.

4. At the top of the tab click the Expand All link.

5. In the new (+/-) field, enter the offset.

6. Click Save.

Apply Floating Adjustments for a Resource's Extended Hours

1. Go to the Labor tab for the plan.

2. Select the Major Task and click Edit Major Task.

3. Expand the tasks and select the resource under the task whose hours you want to
adjust.

4. Select the Hours tab (or Algorithm / Hours).

5. In the (+/-) field, enter the offset.

6. Click Save.

Import Additional Location-specific Overrides from a Plan or
Template

This enhancement expands on to the existing capability, introduced in update 5.6, to
import location-specific overrides from another plan or template, when adding a
location to your plan.

What's changed? Additional location-specific overrides can be pulled into your plan or
template.
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• Grant Amount by Treatment Arm:

• Monitoring Approach data, such as the Percent of SDV

• Plan-level Provider assignments

Note:

System Administrators can turn on this feature for users from Customer
Preferences, under the Admin menu.

Custom Algorithms and Custom Fields Validated for Calculation
Errors

What's changed? When creating or updating custom field default formulas or custom
algorithms via script, ClearTrial validates the plan for any errors that you may have
introduced. For example, if your user-defined formula for a cost item contains a division by
zero, a new View Plan Errors link appears in the top right of your plan which allows you to
view error details or download the list of errors to distribute to other users.

Who sees the change?

• If an error is introduced while your Expert Algorithm Editor is defining a custom algorithm
via script, for a resource or indirect cost, when another user opens that plan, they will
also see the View Plan Errors alert in the plan.

• If your Custom Field Designer introduces an error while defining a custom field in one of
your custom field models, only that user with the Custom Field Designer will see the alert,
since they are the only ones who can fix it.

Other types of errors ClearTrial validates for are the following:

• Issues in task-resource or indirect cost algorithms:

– You are using variables that do not exist in the ClearTrial or the current custom field
model published and applied to the plan.

– The algorithm divides by zero due to an assumption or custom field whose value has
become 0.

– The custom algorithm now returns a negative value.

• Issues in custom field default value formulas:

– You are using variables that do not exist in ClearTrial or the current custom field
model published and applied to the plan.

– Algorithm divides by zero.

– The result of your formula is outside the expected range.

– The formula now returns a negative value.
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New Duration-based Variables for Custom Algorithms using
Script

What's new? Six new duration-based variables are now accessible for use when
defining custom algorithms using script:

• numMonths: Number of months between the PASD and Final CSR.

• numMonthsForCost: Number of months during which this cost occurs.

• numMonthsForTask: Number of months during which the effort occurs for a Task.

• numDays: Number of days between the PASD and Final CSR.

• numDaysForCost: Number of days during which the cost occurs.

• numDaysForTask: Number of days during which the effort occurs for a Task.

Who sees the change? Expert Algorithm Editors who are defining custom algorithms
when switching to script.

Note:

Defining custom algorithms with script is launched by navigating to the Cost
> Adjustments tab for an indirect cost item or the Resource > Algorithm
(or Algorithm/Hours) tab for a resource working on a task and clicking on
the Switch to Script link.

Tip:

For the full list of available variables, see the Script Variables Guide.

Updates to the Web Services API (Enterprise Edition only)
What's changed? Several API resources have been updated so that your developers
can retrieve the data points they need from the updates added to the service.

The Web Services API User Guide has been updated to reflect all the endpoints
accessible in ClearTrial 5.7:

Get Summary: /cleartrial-ws/plans/{planID}/summary

Added code and mappingKey to the existing cost resource.

Get Costs: /cleartrial-ws/plans/{planID}/cost

Added code and mappingKey to the cost resource.

Get Costs Monthly View: /cleartrial-ws/plans/{planID}/cost?view=monthly

Added code and mappingKey to the cost resource.
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Get Labor: /cleartrial-ws/plans/{planID}/labor

Added code and mappingKey to the existing task resource.

Added the floating adjustment for total hours as adjustmentToHours to resource.

Added the % Adjusted value for unit hours as unitHoursPct to resource. Under
unitHoursPct, the default hours are shown as defaultPct and the percentage adjustment is
shown as userPct.

Who sees the change? Developers subscribed to Enterprise Edition with access to leverage
the ClearTrial Web Services API specified in your customer profile.

Note:

You can specify this preference in your initial Oracle ClearTrial Service Activation
Request (SAR) or during your subscription, you can contact your Account Manager
or filing a service request in My Oracle Support.
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4
Changes in Update 5.6

This section includes enhancements and updates made to Oracle ClearTrial Plan and Source
Cloud Service since version 5.5. This release offers the ability to upgrade existing plans and
templates to the latest ClearTrial cost model. As a reminder, upgrading to the latest cost
model ensures you are working with the latest industry updates to both early- and late-stage
ClearTrial-defined Work Breakdown Structures (WBSs) and indirect cost calculations.

To access ClearTrial Cloud Service documentation and videos, please visit the new Oracle
Help Center.

• Update to Responsibilities/Assignment Groups

• New Customer Preference

• Import Location-specific Data from Any Plan or Template

• Model Schedules in Days

• Calculated Dates Display

• Custom Descriptions for ClearTrial-defined Resources

• Rename, Reorder, and Regroup Tasks

• Usability/User Experience Enhancements

• Custom Fields Cap Increase

• Especially for CRO Users

• Web Services API Enhancements

Update to Responsibilities/Assignment Groups
ClearTrial's 5.6 cost model offers the latest updates to the ClearTrial Responsibilities, also
known as ClearTrial-defined Task/Assignment groups, and the tasks under each group.

Updates include new Responsibilities/Assignment groups and updates to existing ClearTrial
Responsibilities group names and the order in which they are displayed on various tabs. The
new task groups displayed for plans using the ClearTrial 5.6 cost model include:

Phase I (Oncology/Vaccines) through Phase IV or Late-Stage Plans:

• Site Startup (New)

• Medical Management (New)

• Safety/Pharmacovigilance (Update to existing group Safety and Medical Management)

• Quality Assurance (Update to existing group Site Auditing)

• DSMB (New)

Phase I (Healthy Volunteers) Plans:

• Site Startup (New)

• Safety/Pharmacovigilance (New)
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• Quality Assurance (Update to existing group Site Auditing)

• DSMB (New)

Additionally, existing ClearTrial-defined tasks have moved and will reside by default
under different Responsibilities/Assignment groups in ClearTrial 5.6 cost model plans
for both WBSs. As a result, default assignments for ClearTrial's Responsibilities have
also changed when compared to plans using the ClearTrial 5.5 cost model.

If you have defined mappings for departments or GL codes by task or task group, you
may wish to review these mappings after the upgrade.

New Customer Preference
ClearTrial 5.6 offers a new customer preference, Allow user to choose a plan or
template from which to pull location-specific data when adding locations to a
plan, for users who are assigned the ClearTrial System Administrator primary role.
This new configuration allows you to turn on or off the ability to import location-specific
data for any plan or template. When this configuration is turned on (set to true), you
will see new prompts in the Add Locations dialog when you add a location to your
plan/template.

This preference allows users to choose a plan or template from which to pull location-
specific data when adding locations to a plan. It can be set to true or false for all users
in your organization. By default, it is set to true for CROs and false for sponsors.

Import Location-specific Data from Any Plan or Template
When the new customer preference, described in the previous session, is set to true,
you see a new prompt when you add a location to your plan/template in ClearTrial 5.6.
On the Choose Locations dialog, after you have selected the location to add, a new
prompt appears toward the bottom of the dialog for you to choose the location-specific
overrides to import from a list of templates or plans (via a new configurable filter).

The list will contain prior/existing completed plans/templates that contain the overrides
made for the specific location. Once you have selected the plan/template (source) to
import the overrides from, you will see the following types of overrides pulled into your
current plan/template (destination):

• Custom Fields

• Location Data (MOH Delay, Ave Grant Amount)

• Site Information (Number of sites, etc.)

• Subject Data (Screening, drops)

• Task Assignments

• Task-Resource Department/GL Code

• Task-Resource Algorithms

• Task-Resource Billing Rate Location

• Task-Resource Rate Overrides

• Task-Resource Unit Hours

• Indirect Cost Assignments
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• Indirect Cost Departments/GL Codes

• Indirect Cost Adjustments

• Indirect Cost Algorithms

• Meetings

• Resource Assignments (made in the Override Resources and Rates dialog)

Model Schedules in Days
In some cases, you may want to model the site approval, enrollment, and/or treatment
duration for late-stage plans in terms of days rather than weeks.

Tip:

If you need to model a Phase I (Healthy Volunteers) plan/template in days, you
don't have to change anything.

• Site Approval Schedule

• Subject Enrollment Period

• Treatment Duration

Site Approval Schedule
ClearTrial 5.6 offers the flexibility to model the site approval schedule per location in days, for
late-stage plans. You can do this by clicking the new Switch to Days link from within the Edit
Site Approval Schedule dialog when editing the schedule.

If you later need to revert back or switch to model the schedule in weeks, ClearTrial 5.6
provides this capability by clicking the Switch to Weeks link from within the schedule.

Subject Enrollment Period
When you are defining the subject enrollment period in late-stage study plans, ClearTrial 5.6
provides the flexibility to select days from a new Enrollment period drop-down list to model
enrollment in days instead of weeks. At any time, when editing your plan, you can switch
back to weeks, if needed.

Treatment Duration
On the Treatment tab, you will see the same drop-down list to model in days when you are
defining the treatment duration, per treatment arm, in ClearTrial 5.6 late-stage plans.

Calculated Dates Display
In ClearTrial 5.6, you will notice calculated read-only dates displayed on various tabs, as you
are creating/overriding related assumption parameters.

• Locations tab—FSA Date (First Site Approved) will dynamically update when you are
configuring the MOH (Ministry of Health) delay value, per location.
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• Subject tab—Last Subject In (LSI) and Last Subject Out (LSO) Dates displayed
when you enter/update the enrollment period.

• Treatment tab—Last Subject Out Date is displayed and will dynamically update
when you are defining your treatment arm.

• Data tab—When you change the number of days from LSO to Db Lock, Db Lock
to Stat Report, Stat Report to Draft Report, or Draft to Final, ClearTrial displays the
corresponding calculated dates on the Data tab. Each date appears below the
current field that captures the offset in days from a specific milestone.

Custom Descriptions for ClearTrial-defined Resources
You can make the descriptions of ClearTrial-defined resources more accurately reflect
your organization's staffing and costing structures by editing or replacing ClearTrial-
defined description. How do you do this?

1. From the Maintain menu, select Resources.

2. From the Resource list, select the CRA and click Edit.

3. Update the Code and Name and click the pencil icon to edit the ClearTrial default
description.

To revert to the ClearTrial default description, click the trash icon to discard the
latest change.

Rename, Reorder, and Regroup Tasks
Users who have licensed the Enterprise Edition can perform the following tasks.

• Customize Names and Descriptions—Within your plan, you can customize the
name and description of each ClearTrial-defined Major Task. To apply these
customizations to future plans, create a template with these settings and any plans
created from the template will inherit the configurations/settings made.

• Resort Major Tasks—The ClearTrial-defined Major Tasks appear in the order in
which they are typically performed in a trial. You can control the order in which
these Major Tasks are displayed on the Labor tab using drag and drop:

1. On the Labor tab, highlight the Major Task you want to move by clicking and
holding the mouse button.

2. Drag the Major Task to where you want it to appear in the Major Task list and
release the mouse button., then click Save.

You can also resort Major Tasks from within the Task Manager by configuring the
new assumption on the Major Task Details tab:

1. Select the Major Task and click Edit Major Task.

2. From the Display this Major Task drop-down list, select before or after.

3. From the drop-down list to the right, select the Major Task before or after to
display the Major Task.

• Change the Task Sorting Order—Within a ClearTrial-defined Major Task:

1. On the Labor tab, select a Major Task and click Edit Major Task.

2. Highlight the task you want to move by clicking and holding the mouse button.
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3. Drag the task to where you want it to appear in the Task list and release the mouse
button then click Save.

• Order of Major Tasks and Tasks Inherited in Reports—The task ordering or major task
ordering will now be inherited in ClearTrial-defined reports. When you resort the tasks,
the same order is used in the ClearTrial-defined reports.

• Move ClearTrial-defined Tasks to Another Assignment Group—You can move
ClearTrial-defined tasks to another assignment group to align the groups with your
organization's notion of services or responsibilities.

1. On the Labor tab, select a Major Task and click Edit Major Task.

2. Select a task and click Edit Task.

3. To change the Assignment Group, select a different assignment group from the drop-
down list. Assignment groups are represented by radio buttons in the Responsibilities
section of various tabs and as drop-down lists on the Assignment tab.

4. Click Save.

• Change the Summary Category for ClearTrial-defined Tasks—You can change the
Summary Category, from Task Details tab within Task Manager, to move ClearTrial-
defined tasks from one summary group to another so that user can align the categories
with your organization's notion of how work should be summarized.

1. On the Labor tab, select a Major Task and click Edit Major Task.

2. Select a task and click Edit Task.

3. To change the Summary Category, select a different category from the drop-down
list. Summary categories determine how the hours and fees are summarized (rolled
up) and displayed on the Summary tab and Summary report.

4. Reorder the tasks by specifying whether this task should appear before or after the
other task you select from the drop-down list. From the Display this Major Task
drop-down list, select before or after. From the drop-down list to the right, select the
Major Task before or after to display the Major Task.

5. Click Save.

Usability/User Experience Enhancements
ClearTrial 5.6 includes new capabilities to let you get more done quickly and easily, making
your ClearTrial experience even more powerful.

• Locations tab—The footer row displays the total number of locations and updates
dynamically if the number of locations changes. The footer row also shows the total
number of sites, the total number of subjects, the number of translations/dialects, the
average length of MOH/FDA delays, and the weighted average of the investigator grant
amounts.

• Treatment tab

– Depending on the number of visits you specify, you can specify a treatment duration
as short as one day or one week.

* For a parallel trial design, you can specify one week with eight visits or one day
with two visits.

* For cross-over trial design, you can enter one week with seven visits or one day
with one visit.
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– The number of subject visits can be greater than the treatment duration.

– You can specify less than one minute of monitoring time for simple CRF pages
per treatment arm schedule.

• Monitoring tab—In the On-Site Monitoring Schedule section, the total number of
sites used in the plan is displayed.

• Meetings tab

– You can show or hide excluded meetings in the Meetings list.

– The number of meetings selected from the Meetings list is displayed at the top
of the Meetings section.

– You can sort attendees on Resource Type, Billing Rate Location, and
Attendance Method by clicking the corresponding column headers. The order
in which you click the column headers governs the sort. For example,
Resource Type sorted by Billing Rate Location and then by Attendance
Method.

• Task Manager

– (Enterprise Edition only) The Distribution tab of a Major Task within Task
Manager displays the number of weeks between the distribution start and end
dates for each service provider/location. This allows you to quickly determine
the number of weeks used for each country without having to count the
individual rows of weeks.

– You can copy a user-defined task by selecting the task and clicking the Copy
Task button.

– The Code field on the Task Details tab is now editable for ClearTrial-defined
tasks. You can enter a code. You can edit it over time, when you edit the task
later. You can also use it as a prefix to help order the list in which it is
displayed in.

• Labor tab—(Enterprise Edition only) You can copy a user-defined Major Task by
selecting the Major Task you want to copy and clicking the Copy Major Task
button.

• Reports tab

– When you run the Meetings Report for your plan, you will see two new options:
Include Resources With No Meeting Hours and Use Resource Name
Instead of Resource Type.

– On the Plan Reports tab, a new plan-level report, Compare to Original, has
been added to compare the current plan to its template or prior copy and
quickly see differences or changes in fees and costs.

• Context-sensitive Help—Two capabilities have been added:

– You can now select and copy the text from the context-sensitive help screens.
When you click a field name to open the online help associated with the
screen. The keystrokes depend on which browser you are using. For example,
in Internet Explorer, click CTRL+SHIFT+DBL-CLICK. to copy the contents to
the clipboard. In other browsers, these keystrokes make the text become
selectable so you can copy all or part of the text.

– The table of Major Tasks that appears in the help for the Labor tab is dynamic.
It reflects tasks and Major Tasks that have been added or are unique to the
current plan as well as any changes you make to the name or description.
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Custom Fields Cap Increase
The total number of custom fields permitted has increased to 350. Default formulas can be
applied to 75 of them.

Note:

The more custom fields you add to your plans, the more you might experience slight
changes to performance.

Especially for CRO Users
Several capabilities to support have been included in ClearTrial 5.6 specifically for CRO
users.

• The header at the top of all screens includes Sponsor Name.

• The Overview tab includes an additional assumption which gives you the option to
include/exclude Sponsor hours from your budget plan. By default, sponsor hours are
excluded for CRO users.

• You can display a Sponsor column on the Plans list screen. Select the Configure List
Options link on the Plans list screen and select Sponsor. You can also filter the plans list
by sponsor.

• When working with meetings tasks, meeting tasks assigned to sponsors have been
removed.

• When you open the Assignment ab, all tasks have been expanded by default.

• ClearTrial no longer includes sponsor oversight and sponsor-only tasks in the WBS (both
WBSs) for CRO customers. On the Assignment tab, you won't see the Assignment Group
for Sponsor Oversight. In the Task manager, all Sponsor Oversight Major Task and Tasks
are hidden.

Web Services API Enhancements
ClearTrial 5.6 Web Services API has been updated to include additional endpoints that users
can retrieve or export.

If you are a Plan Enterprise customer and your development/IT team would like additional
technical information, please refer to the Web Services API User Guide on the Oracle Help
Center.
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5
Changes in Update 5.5

This section includes enhancements and updates made to Oracle ClearTrial Plan and Source
Cloud Service since version 5.4.

• Advanced Algorithms

• New User Role/Additional Capability

• New Medical Monitoring and Safety Assumptions

• Refined Assumption Defaults

• Renamed Assignment Groups

• Work Breakdown Structure Updates

• Important Note for New Resource Department Assignments

• Medical Monitoring Algorithm Updates

• Renamed Safety Tasks

• Safety Task Updates

• New Units of Measurement

• New Plan Summary Group

• Indirect Cost Usability Enhancements

• Expanded Browser Support

• Web Services API Enhancements

Advanced Algorithms
Configurability capabilities currently exist at the labor and indirect cost levels to allow you to
align to your organizational hierarchy or the mutually agreed upon work breakdown structure
determined between you and your service provider(s). Oracle ClearTrial has become the
platform that triggers contract negotiation discussions for complete alignment and
transparency between both sides (sponsor, vendor) of the ecosystem.

Oracle ClearTrial 5.5 expands on existing user-defined algorithm building capabilities by
allowing the configuration of multiple expressions with multiple cost drivers accessible per
expression, per algorithm. This enhancement provides increased control and flexibility over
how custom fees and costs are specified to align to their respective clinical trial scenario.

ClearTrial 5.5 also includes a new configurable assumption within each expression to apply a
percentage of, per cost driver, per expression. This percentage will increase/decrease the
number derived from the underlying assumption for the driver.

There may be ClearTrial-defined costs and fees included by default at a different level of
granularity than those in which your organization needs or for your planned trial's budget. You
can leverage the 5.5 advanced algorithm capabilities so that you can include those specific
fees or costs in your budget, when you need them (on demand).

5-1



New User Role/Additional Capability
Oracle ClearTrial 5.5 includes the additional role/capability of Advanced Algorithm
Editor. This permission is for users who need write access to create or edit task-
resource /cost algorithms with multiple expressions.

Assigned ClearTrial System Administrators have this additional permission by default
and can grant it to any user who is already assigned the Power User, Clinical
Administrator, or System Administrator primary role.

New Medical Monitoring and Safety Assumptions
Oracle ClearTrial 5.5 includes updates to existing medical monitoring and safety
algorithms, including new, configurable assumptions used to calculate monitoring-
related fees and costs accessible for late-stage studies, for users in Advanced/Expert
mode.

All new assumptions/cost drivers will be displayed on associated out-of-the-box
reports and accessible as a unit of measure to select from when creating user defined
algorithms.

• Lab and Diagnostic Tests per subject, per treatment arm located on the Plan
Treatment tab. This assumption's value is used to calculate the amount of time the
medical monitor will spend reviewing lab and diagnostic test results.

• Cohort Escalation Reviews per treatment arm located on the Plan Treatment
tab. This assumption's value is used to calculate the time required for the medical
monitor and medical associate to determine appropriate changes in dosage.

• 24/7 Coverage for Medical Monitoring located on the Plan Monitoring tab. This
assumption's value is used to increase the estimated time the medical monitor and
medical associate will spend performing subject eligibility reviews, answering
specific inclusion/exclusion criteria questions, and reviewing subject management
and protocol issues that require medical judgment.

• Medical Data Listing Reviews located on the Plan Monitoring tab. This
assumption's value is used to calculate the amount of time the medical monitor
and medical associate will spend assessing point-to-point data, data across visits
per subject, data across subjects per site, and data across the entire study.

Refined Assumption Defaults
Oracle ClearTrial 5.5 includes intelligent default value updates for the assumptions
listed below.

• Hours medical monitor will spend with each SAE

• Expected percent of SAE reports to be expedited

Renamed Assignment Groups
Oracle ClearTrial 5.5 includes new and updated ClearTrial-defined Major Tasks, Tasks,
and resources for late-stage studies. Please refer to the tables below for detailed
updates.
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Table 5-1    Renamed Assignment Groups in 5.5

5.4 Assignment Group 5.5 Assignment Group

SAE Management Safety and Medical Management

Work Breakdown Structure Updates
Oracle ClearTrial 5.5 includes new and updated ClearTrial-defined Major Tasks, Tasks, and
resources for late-stage studies. Please refer to the following tables for detailed updates.

Table 5-2    New Major Tasks and Tasks in 5.5

New Major Tasks Associated Tasks

Medical Data Listing Review Review medical data listings

Subject Monitored Review clinical data and CRFs

Subject Monitored Review alert lab and diagnostic test results

Cohort Escalation Review Review data to determine dose escalation

Table 5-3    Existing Labor Updates in 5.5

Existing Major Tasks Associated Tasks

Study Setup Safety system setup

Study Setup Develop SAE management plan

Study Setup Prepare therapeutic training materials

Project Management Week after FSI Post-FSI — Manage safety processes

SAE Processed Process SAE

SAE Processed Enter data and perform quality review

SAE Processed SAE reconciliation

Expedited Safety Report Completed Produce expedited safety report

Expedited Safety Report Completed Expedite safety reports to central ethics
committees

Expedited Safety Report Completed Expedite safety reports to local ethics committees

Expedited Safety Report Completed Expedite safety reports to sites

Sponsor Oversight Oversee — Cohort escalation review

Sponsor Oversight Oversee — Medical data listing review

Sponsor Oversight Oversee — Subject monitored

Table 5-4    New Resources Available in 5.5

Resource Name Resource Code

Medical Associate DS02

Safety Specialist PV01
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Table 5-4    (Cont.) New Resources Available in 5.5

Resource Name Resource Code

Safety Coordinator PV02

Safety Database Administrator PV03

Table 5-5    New Resource Effort in 5.5

Tasks Resources

Develop scope of work, timeline, work assignment Safety Specialist

Review protocol Medical Monitor

Coordinate DSMB setup activity Medical Monitor

Coordinate DSMB setup activity Medical Associate

Internal Team Meeting Medical Associate

Medical monitoring Medical Monitor

Medical monitoring Medical Associate

Expedite safety reports to regulatory agencies Regulatory Submissions Specialist

Expedite safety reports to regulatory agencies Safety Specialist

Write the SAE narrative Safety Specialist

Write the SAE narrative Medical Monitor

Conduct medical review of the SAE Medical Monitor

Design study documents Safety Specialist

Design study documents Safety Coordinator

Oversee — Study Setup Clinical Research Associate

Oversee — Study Setup Safety Specialist

Oversee — Project Management Week after FSI Medical Monitor

Oversee — Project Management Week after FSI Medical Associate

Oversee — Project Management Week after FSI Safety Coordinator

Oversee — SAE Processed Safety Specialist

Oversee — SAE Processed Safety Coordinator

Oversee — Expedited Safety Report Completed Safety Specialist

Oversee — Expedited Safety Report Completed Safety Coordinator.

Table 5-6    Resource Effort Removed in 5.5

Tasks Removed Resources

Produce and distribute subject information
video

Medical Monitor

Review CRF (or EDC equivalent) Medical Monitor

Conduct medical review of the SAE Senior Vice President Clinical

Conduct medical review of the SAE Project Manager

Collect the SAE data from the investigator Medical Monitor
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Table 5-6    (Cont.) Resource Effort Removed in 5.5

Tasks Removed Resources

Write the SAE Narrative Senior Director, Clinical/Therapeutic

Expedite safety reports to regulatory agencies Director, Regulatory Affairs

Oversee — SAE Processed Clinical Research Associate

Oversee — SAE Processed Project Admin Assistant

Important Note for New Resource Department Assignments
If your organization has never created custom department mappings prior to using the
Maintain Departments capability, accessible from the Maintain menu, then the new resources
available in 5.5 will contain a ClearTrial pre-defined default department mapping. However, if
your organization has previously taken advantage of/leveraged this ability to manage and
maintain your custom department mappings over time for your plans, then please review the
mappings per resource post release. The new resources available in 5.5 will have
"Unmapped" as their default department assignment. Please meet with your users and
determine if the new resources need updated mappings based on your current organizational
structure.

Medical Monitoring Algorithm Updates
Oracle ClearTrial 5.5 updates the ClearTrial-defined algorithm to calculate the level of effort
required for medical monitoring to be based on the site weeks and number of patients per
location. This updated algorithm includes impact to the resources listed below, who are
performing work on this task.

• Medical Associate (new in 5.5)

• Medical Monitor

This algorithm update also affects an existing assumption from 5.4 and prior and removes
Number of FTE (full-time equivalent) Medical Monitors from the 5.5 cost model.

Renamed Safety Tasks
Oracle ClearTrial 5.5 includes renamed existing tasks to remain current with industry-
standard terminology:

Table 5-7    Renamed Safety Major Tasks

5.4 Major Task Name 5.5 Major Task Name

Expedited SAE report completed Expedited safety report completed

SAE report completed SAE processed
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Table 5-8    Renamed Safety Tasks

5.4 Task Name 5.5 Task Name

Expedite SAE reports to regulatory agencies
and ethics committees

Expedite safety reports to regulatory agencies

Oversee — Expedited SAE report Oversee — Expedited safety report completed

Oversee — SAE report completed Oversee — SAE processed

Safety Task Updates
The following safety tasks included in ClearTrial 5.4 and prior cost models are not
included in the 5.5 cost model.

• SAE Database programmed

• Program the SAE database

• Collect the SAE data from the investigator

• Enter the SAE data

• Code the SAE report

• Send final SAE report to sponsor

• Oversee — SAE database programmed

New Units of Measurement
New accessible work units in 5.5 cost model when creating task-resource algorithms
and user-defined miscellaneous or pass-through costs include:

• Medical Data Listing Review (related to new medical monitoring assumptions)

• Cohort Escalation Review (related to new medical monitoring assumptions)

• Grant Payment

New Plan Summary Group
Oracle ClearTrial 5.5 includes a new summary group for Safety and Medical
Management, displayed primarily on the Plan Summary tab and associated reports.
This new summary group includes the following direct labor fees:

• Post-FSI - Manage safety processes

• Process SAE

• Enter data and perform quality review

• Conduct medical review of the SAE

• SAE reconciliation

• Produce expedited safety report

• Expedite safety reports to regulatory agencies
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• Expedite safety reports to central ethics committees

• Expedite safety reports to local ethics committees

• Expedite safety reports to sites

• Review medical data listings

• Review clinical data and CRFs

• Review alert lab and diagnostic test results

• Review data to determine dose escalation

• Medical monitoring

Indirect Cost Usability Enhancements
Oracle ClearTrial 5.5 provides several usability enhancements to the Plan Costs tab.

• New Cost Assignments tab when creating/editing a user defined cost.

• All cost assignments, including provider, department, and GL Code assignments will be
accessible from the Cost Assignments tab.

• Existing cost specifications, such as the scope of the cost (by study or by location), have
been relocated to the existing Cost Definition tab.

• Plan Cost tab includes a cost selection indicator to indicate to the user how many cost
items have been selected from the list.

• Increased number of characters allowed for user-defined cost names.

Expanded Browser Support
Oracle ClearTrial 5.5 provides support for Microsoft Internet Explorer 11.

For inquiries on supported browsers and Oracle ClearTrial recommendations, refer to the
Oracle ClearTrial 5.5 Technical Requirements available from the ClearTrial Support Center.

Web Services API Enhancements
Oracle ClearTrial 5.5 Web Services API includes enhancements to provide additional
endpoints available for Plan Enterprise Edition customers. As a reminder, if you are a Plan
Enterprise customer and your development/IT team would like additional technical
information, please refer to the Web Services API User Guide by release accessible from the
ClearTrial Support Center.
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6
Changes in Update 5.4

This section includes enhancements and updates to Oracle ClearTrial Plan and Source Cloud
Service from the previous version, 5.3.

• Important Note on Freezing Billing Rates

• Locking Plans Best Practice Update

• Important Points on Existing Locked Plans that Are Unlocked/Copied

• Clinical Intelligence Updates

• Introduction of Cost Model Versioning from 5.3+

• Custom Assumptions

• Bid Comparison across RFPs

• Line-item Discount Support

• New Units of Measurement/Cost Drivers

• Increased Transparency for Meetings Labor

• Metrics Updated to Include Inflation

• Bid Grid Versioning

• Usability Enhancements

• Web Services API Enhancements

• Freezing Billing and Inflation Rates: Information and Guidelines

Important Note on Freezing Billing Rates
Oracle ClearTrial 5.4 includes updates to composite billing rates for years 2017 – 2039.

Freezing rates remains an Oracle ClearTrial release best practice to preserve existing rates
in 5.3 (or earlier) plans.

Locking Plans Best Practice Update
Locking plans preserves assumption values and freezes resource billing rates and inflation
rates in existing plans.

Upon the release of 5.4, existing plans will no longer be automatically upgraded to the cost
model associated with the latest release of ClearTrial Cloud Service.

Therefore, locking plans is no longer required to preserve values prior to a ClearTrial release.
Locking plans is now strictly a method to prevent users from making inadvertent changes to
an existing plan.
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Important Points on Existing Locked Plans that Are
Unlocked/Copied

• When a plan that is locked to a version earlier than 5.3 is unlocked, it will be
upgraded to the first supported cost model.

• Copies of a locked plan, locked to a version earlier than 5.3 will be upgraded to the
first supported cost model.

• Copies of 5.3 locked plans will continue to use the 5.3 cost model, but users have
the ability to upgrade per plan, on demand.

For more information, see Locking Plans: Information and Guidelines and Freezing
Billing Rates: Information and Guidelines.

Clinical Intelligence Updates
Oracle ClearTrial 5.4 includes updates to composite billing and inflation rates.

• Composite Billing Rate Updates

• Composite Inflation Rate Updates

Composite Billing Rate Updates
Oracle ClearTrial 5.4 introduces composite billing rate updates for years 2016 to 2029,
based on estimated inflation, observed provider billing rates by location, and industry
salary projections. ClearTrial will adjust future years for inflation, according to the
ClearTrial-defined inflation profiles, by location and year.

ClearTrial continuously monitors and aggregates changes in provider billing rates.
These composite rates are reviewed annually and updated to ensure that the most
current and accurate composite rates are available.

Composite Inflation Rate Updates
Oracle ClearTrial 5.4 introduces composite inflation rate updates for years 2016 to
2039, based on global economic data.

ClearTrial continuously monitors and aggregates changes in global inflation rates.
These composite rates are reviewed annually and updated to ensure that the most
current and accurate composite rates are available.

Introduction of Cost Model Versioning from 5.3+
Oracle ClearTrial plans calculate level of effort, costs, distributions, and timelines logic,
default values, and a work breakdown structure referred to as a “cost model." A new
cost model is created with every ClearTrial release and will now be referred to using
the release version number. For example, upon release of 5.4, the cost model will be
called “cost model 5.4." Oracle ClearTrial will now support multiple cost models
simultaneously.

All cost models from 5.3 and forward will be preserved and available for use in plans.
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• Existing Plans and Templates

• Updating Plans to a new Cost Model: Best Practice

• New Plans and Templates

• Maintaining Templates: Best Practices

Existing Plans and Templates
Users will have the ability to decide whether or not to apply a cost model to a plan.

For example, users can choose to leave a plan (or template) created in cost model 5.3 in its
current state. Should the user later choose to update an assumption or a default value in that
plan, the plan values will recalculate using the logic from the 5.3 cost model.

Conversely, the user can choose to update a plan (or template) created in cost model 5.3 to
cost model 5.4. In this case, the user's overwritten values will be preserved but all default
values, logic, and tasks will be based on cost model 5.4. The plan labor and cost values will
change to reflect the new model.

Cost models prior to version 5.3 have not been preserved; therefore, plans (or templates)
locked to earlier versions (5.2 and less) when upgraded, will be upgraded to 5.3 at minimum,
with the capability to upgrade to 5.4 on demand.

Updating Plans to a new Cost Model: Best Practice
If you have an existing plan or template that was locked prior to 5.3, you should not unlock it
unless you are prepared to accept the changes that will occur as the plan adjusts to the
oldest preserved cost model, which is the 5.3 cost model. Once the cost model is updated,
you will not be able to revert the cost model back to a version prior to 5.3.

If you want to assess the potential impacts of a newer cost model on fees and costs without
impacting your original plan, ClearTrial recommends that you:

1. Copy the plan.

2. Updating the cost model of the copy.

3. Compare the copy to the original plan.

If you do not like the resulting changes, you can delete the updated copy and your original
plan will still be available.

New Plans and Templates
If a user creates a new plan based on a custom template, the new plan will reflect the cost
model of the template.

If a user creates a new plan based on the ClearTrial default template, the new plan will reflect
the current version cost model.

If a user wants to create a new plan using an old custom template and the newest cost
model, the user can either:

• Create the plan based on the old custom template and then upgrade the plan to the
newest cost model, or

• Upgrade the template to the newest cost model and then create the plan from the
upgraded template.
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Maintaining Templates: Best Practices
As of 5.4, the following best practices are recommended upon release of the new cost
model:

• Copy your custom templates.

• Upgrade them to the current cost model version.

• Review the impact of ClearTrial's new cost model version.

• Edit your templates, if necessary.

• Instruct your users to create new plans based on the new templates.

You can leave templates based on older cost models available for users or you can
archive them.

Note:

If you want the billing rates to remain the same from release to release,
ClearTrial still recommends that you freeze rates prior to a new Oracle
ClearTrial release because billing rates are not preserved as part of a cost
model.

Custom Assumptions
Oracle ClearTrial 5.4 allows Oracle Health Sciences ClearTrial Plan Enterprise Edition
Cloud Service users to create their own custom assumptions. Users might want to
create a custom assumption when ClearTrial does not have a defined assumption that
meets their need for calculating a custom task or for use as a unit of measure for
billing.

• User Additional Roles/Capabilities

User Additional Roles/Capabilities
Oracle ClearTrial 5.4 includes the additional role/capability of Custom Field Designer.
This permission can be granted to users who need access to create custom fields and
publish custom field models for use in plans. A training video is available for users who
will be designated as custom field designers.

ClearTrial system administrators have this additional permission by default and can
grant it to any user who is already assigned the Clinical Administrator or System
Administrator primary role.

Bid Comparison across RFPs
In 5.3, you could only compare bids that existed within the same RFP. Oracle
ClearTrial 5.4 provides the ability to compare bids from different RFPs. This allows you
to perform a comparison of bids that have been generated from copies of plans to see
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how bids have changed when the same trial's scenario is updated in response to vendors'
alternatives.

Line-item Discount Support
Oracle ClearTrial 5.4 provides the ability to apply line-item discounts per plan per provider.
Line-item discounts are not associated with any particular major task, task, resource, or rate.
This kind of discount is a negotiated amount at the plan level that gets applied against the
overall labor fees for a particular plan provider.

If you configure a line-item discount in your plan, all ClearTrial-defined reports have been
updated to display discount impact to total fees. For the Metrics report, you can specify that
the metric calculations consider line-item discount.

New Units of Measurement/Cost Drivers
Oracle ClearTrial 5.4 exposes additional items to be used as units of measurements when
creating task-resource algorithms in Task Manager or as cost drivers when creating user-
defined miscellaneous or pass-through costs on the Costs tab. The items below are now
available to be used as units of measurements or cost drivers.

• Pre-study Site Visit*

• Site Initiation Visit*

• Site Close-out Visit*

• Newsletter

• Publication

*Related to onsite visits only, not phone visits.

Increased Transparency for Meetings Labor
Oracle ClearTrial 5.4 provides increased transparency for meetings. In 5.3, meeting tasks
were created for each unique provider attending the meeting. Regardless of billing location,
multiple occurrences of the same resource for a meeting were merged together into one
resource in the WBS. The billing rates for those resources were blended to derive the
associated fees.In 5.4, meeting tasks will now be created for each unique provider, resource,
and billing location combination. When the associated fees are calculated, the billing rates
are no longer blended. The actual billing rate for the resource's billing location will be used to
derive the associated fees.

Metrics Updated to Include Inflation
Oracle ClearTrial 5.4 provides increased flexibility by allowing the user to apply inflation to
metrics. Because ClearTrial-defined metric calculations are not versioned, metrics with the
option to include inflation will be available in 5.3 plans.

The following metrics have been updated with the ability to include inflation on the ClearTrial-
defined Metrics Report:

• Total study cost per CRF page (includes drop rate).

• Data management cost per CRF page (excludes Biostatistics).
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• Total study cost per on-site monitoring day.

• Cost to monitor all sites for one additional month.

• Average cost per monitoring trip (excludes pass-through costs).

• Average cost for a single monitoring day (excludes pass-through costs).

• Cost per site per week.

• Study startup costs per site per week.

• Cost per subject per site per week.

• Cost per completed subject.

• Direct Fees per Enrolled Subject.

Bid Grid Versioning
Oracle ClearTrial 5.4 introduces bid grid versioning, which preserves the format and
metadata of a bid grid generated from ClearTrial RFPs even if bid grid changes occur
in the next ClearTrial release. This feature allows you to continue to produce bid grids
for negotiations that may span multiple releases with the same format and metadata.

Usability Enhancements
Usability enhancements are ongoing to enhance the ClearTrial user experience.

• Sort Plans by Protocol and Product/Compound

• Select All Option

• Inactive Templates Removed from New Plan Dialog Box

• Enhanced Reporting Options for Metrics Report

Sort Plans by Protocol and Product/Compound
Oracle ClearTrial 5.4 provides additional data display options to sort by on List
screens. Launched by clicking the Configure List Options link in the upper right-hand
corner of the Plan List screen, Protocol and Product/Compound have been added as
options for you to select from to display as columns by which to sort your plans As a
reminder, if you have a large amount of plans, spanning multiple pages, you can also
configure how many plans are shown per page by increasing the value for the Show
number of plans per page assumption, located at the bottom of the same dialog box.

Select All Option
Oracle ClearTrial 5.4 allows you to quickly select all list items with a single click for the
following:

• Locations on the Location tab.

• Languages on the Location tab.

• Providers on the Provider tab.

• Meetings on the Meetings tab.
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Inactive Templates Removed from New Plan Dialog Box
Oracle ClearTrial 5.4 no longer displays Archived or Study Complete templates as choices
when creating a new plan. This keeps the template list focused on active templates only.

Enhanced Reporting Options for Metrics Report
Oracle ClearTrial 5.4 provides new reporting options for the Metrics Report. New options
control whether line-item discounts and inflation are included in your metric calculations. The
option for line-item discounts is displayed only if a line-item discount exists in your plan.

Web Services API Enhancements
Oracle ClearTrial 5.4 includes enhancements to the Web Services API.

• Inclusion of study ID of each plan's parent study in the Plan Resource API.

• New RFP Resource API to obtain RFPs and related details.

Freezing Billing and Inflation Rates: Information and Guidelines
Oracle ClearTrial 5.4 includes changes to composite billing rates for years 2016 - 2029 and
composite inflation rates for years 2017 - 2039. If you do not want these new rates applied to
your existing plans, you can freeze your rates.

• How to Freeze Billing and Inflation Rates for a Plan

• How to Unfreeze Billing and Inflation Rates for a Plan

How to Freeze Billing and Inflation Rates for a Plan
On the Plans screen, select the plan, click Other Actions, and select Freeze Billing Rates.
You can freeze billing and inflation rates for a single plan or multiple plans in the same step.

How to Unfreeze Billing and Inflation Rates for a Plan
On the Plans screen, select the plan, click Other Actions, and select Unfreeze Billing
Rates. You can unfreeze billing and inflation rates for a single plan or multiple plans in the
same step.
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7
Changes in Update 5.3

Update 5.3 includes enhancements to the Oracle ClearTrial Plan and Source Cloud Service.
This section highlights changes from the previous release of the software, 5.2.

• New Assumption for Monitoring Minutes for CRF Pages

• New Data Assumptions for Repeat Tables, Listings, and Figures

• User Configurable Columns

• New Default Data Collection Method

• Rounding Values

New Assumption for Monitoring Minutes for CRF Pages
ClearTrial 5.3 provides an additional treatment assumption to accommodate monitoring
minutes needed for CRF pages. On the Edit Plan screen, from the Treatment tab, you now
have the option to enter the monitoring minutes per CRF page for each treatment in the
study.

The application calculates the default value for the Monitoring Minutes per CRF Page field
based on the study phase and therapeutic indication. You can override this value for each
treatment. Overridden values do not affect minute per page values for the baseline visit or
washout period for a crossover study.

• Enhancements to Assumptions and Metrics Reports

• Enhancement to the Compare Plans Report

Enhancements to Assumptions and Metrics Reports
The Assumptions report now includes an assumption for the monitoring minutes per CRF
page for each treatment included in your study.

The Metric report now includes an assumption for the average number of minutes to monitor
one CRF page.

The Assumption and Metrics reports are available on the Edit Plan screen, from the Reports
tab.

Enhancement to the Compare Plans Report
The Compare Plans report now includes an assumption for the Monitoring Minutes per CRF
page for each treatment included in you study, in the Treatment Details section of the Report.
The Compare Plans report is available on the Plans screen.
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New Data Assumptions for Repeat Tables, Listings, and
Figures

ClearTrial 5.3 provides new assumptions that allow you to accommodate repeated
data tables, data listings, and figures and graphs. These fields are available from the
Edit Plan screen, on the Data tab. The application calculates a default value for these
fields based on the Number of Unique Pages field, however, you can override this
value. These new assumptions are available for all study phases.

In addition, the repeat data tables, listings, and figures and graphs appear as work
units you can select within task manager. These work units are available from the Edit
Plan screen, from the task manager on the Labor tab.

This release also incorporates new assumptions for repeated PK/PD data tables,
listings, and figures and graphs. These fields are available from the Edit Plan screen,
on the Data tab.

• Enhancements to Assumptions and Compare Assumptions Report

Enhancements to Assumptions and Compare Assumptions Report
The Assumptions report now includes assumptions for repeated data tables, data
listings, and figures and graphs. The Assumptions report is available on the Edit Plan
screen, from the Reports tab.

The Compare Assumptions report also includes assumptions for repeated data tables,
data listings, and figures, and graphs. The Compare Assumptions report is available
from the Plans screen by selecting two or more plans and clicking the Compare
button.

User Configurable Columns
Users can select which columns the application displays with the Configure List
Options dialog box available from the Filter section on the Plans, Studies, Products,
Templates, Portfolios, Resources, Departments, GL Codes, and Exchange Rate
Tables screens. To access this feature, click the Configure List Options link.

New Default Data Collection Method
ClearTrial 5.3 has been updated to provide a new default data collection method on
the Data tab, available from the Edit Plan screen. The new default when creating new
plans is Electronic Data Capture (EDC). You can override this value by selecting
another data collection method from the drop-down list.

Rounding Values
ClearTrial 5.3 includes changes for how values are rounded throughout the
application.

• Rounding Values in Plans

• Rounding Values in Task Manager
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Rounding Values in Plans
On the Edit Plan screen, from the Summary tab, the application rounds to the thousandths
place for hours by department.

All rates, unit costs, and extended costs that appear on the Edit Plan screen are now rounded
to the number of decimal places that is the standard convention for the relevant currency. The
application uses these rounded values for all calculations.

Rounding Values in Task Manager
In the Task Manager, on the Unit Hours tab, Major Task Adjustments tab, and the
Adjustments tab, the default unit hours and unit hours round to thousandths place. The
rounded value appears in the application and is used to calculate the unit cost and extended
unit hours. Overridden values are also rounded to the thousands place.
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